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Introduction
One of the most important indicators of a high-quality site is absence of broken links. There
is nothing worse for a user than coming across either a link that leads nowhere or an empty
square instead of an image. Broken links ruin your reputation and bring down your rating on
search engines. For example,  Google rates your site lower if it  finds broken links there.
Broken links are not just errors in the design of a site that can be overlooked, but they can
cost you rating, traffic and money.

Thus, you need a program that would search all pages of your site for broken links and give
you a detailed report about all found broken links. The program must check links to all
pages both on this and external sites,  the availability of images, scripts, style sheets and
other objects linked to pages. It must be able to check links on the entire site, on one of its
pages or in one directory.

Fast Link Checker is used for searching sites for broken links. It works like a robot of a
search engine (Googlebot, MSNBot, WISENutbot, Alexa, etc.). You specify the file to start
checking from and Fast Link Checker goes through all pages this file has links to until it
checks all links on the site. If Fast Link Checker finds a broken link, it shows its position in
the document, the cause why it does not work and a hint how it can be fixed. Fast Link
Checker  has  a  flexible  management  system and can check links  to  documents,  images,
scripts and other files. You can check links either only on one page or restrict the level of
subdirectories. Fast Link Checker can check links in files available via the HTTP, HTTPS,
FTP or FILE protocols and ignores all Gopher, Chrome, News and mailto: links. It supports
HTTP, HTTPS and SOCKS proxy servers. Fast Link Checker allows you to generate and
save reports. It implements a multithreaded algorithm allowing it to download and check
several pages at a time, which considerably increases the performance. 

Key features
• Small and easy to use;

• Checks all pages on a site for broken links;

• Checks all pages on a site for broken links to graphic objects;

• Checks all pages on a site for broken links to scripts, style sheets and other objects;

• Works like a robot of a search engine (Googlebot, MSNBot, WISENutbot, Alexa, etc.);

• Checks all static and dynamic HTML pages;

• Downloads and checks several pages at a time;

• Checks links in files available via the HTTP, HTTPS, FTP and FILE protocols;

• Checks links in password-protected files and directories;

• Customizable user-agent identification, identifies itself in the user-agent field so you can
see its visits in your log;

• Obeys voluntary robot guidelines, including the robots.txt standard for exclusion of files;
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• Supports HTTP, HTTPS and SOCKS proxy servers;

• Allows you to create reports and save them to a file or send to email;

• Includes command line tool that can be launched from the command line or from batch
files;

• Optimized for Windows XP and for Accessibility; 

• Free support and upgrades to registered users.

System requirements

Software
Fast Link Checker supports the following operating systems: Windows 95, Windows 98,
Windows ME, Windows NT, Windows 2000, Windows XP and Windows 2003. 

Hardware
Fast  Link Checker can be run on any computer  running one of the following operating
systems:  Windows  95,  Windows  98,  Windows  ME,  Windows  NT,  Windows  2000,
Windows XP or Windows 2003. 

To  install  Fast  Link  Checker,  you will  need  at  least  4.5  MB of  free  disk  space.  And
additional disk space will be required depending on the size of the checking site.

Installation
How to Install Fast Link Checker:

1) Download the latest version of Fast Link Checker from our site;

2) Run the installation program;

3) After installation, Fast Link Checker will initially execute with the default settings. 

Updating and reinstalling Fast Link Checker:

If you want to upgrade your Fast Link Checker version, download the latest version from
our site and start the installation program. During the installation process all system changes
will be made automatically. Program will be upgraded but your preferences and registration
information will be kept.

Uninstalling Fast Link Checker:

If you want to uninstall Fast Link Checker, open Add/Remove Programs applet from your
Control  Panel,  select  Fast  Link  Checker  (Remove  only) item  from  the  list  on
Install/Uninstall tab and click Add/Remove… button.
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Registration
You are free to evaluate Fast Link Checker for 30 days period, after which you must either
register it or remove from your hard disk. Registering Fast Link Checker will bring you:

• remove nag screen and enable all features of the product; 

• get an unlimited technical support by e-mail; 

• get all future versions of the appropriate product for free. 

Registering Fast Link Checker costs $49 U.S.

All  registrations  are  made  through  special  secure  server  provided  by  the  authorized
registrator - “Share*It”. You may register our products using secure or normal connection.
Secure  connection  means,  that  all  information  will  be  encrypted  before  transmission  to
prevent  possible interception by a third party. Your transmissions  while in  this  area are
absolutely secure and private. If you run into a problem, please feel free to contact us at
sales@webtweaktools.net. We will be happy to help you.

Order by CREDIT CARD

The most convenient, fast and secure way to register is on-line registration on the ShareIt!
site. They accept Visa, MasterCard, American Express, Discover and EuroCard. After you
have submitted your registration form, you will receive the registration code in 24 hours.
The Secure Order Form for Fast Link Checker can be found at:

https://secure.shareit.com/shareit/checkout.html?productid=300015402&language=English

If you are having difficulty accessing our secure server, please visit non-secure:

http://www.shareit.com/programs.html?productid=300015402&language=English

Alternatively, you can go to  http://www.shareit.com and enter the program number there:
300015402. 

If you do not have access to the Internet, you can register via phone, fax or postal mail.

Ordering by FAX or PHONE

If you do not want to submit your order and credit card information online, you can also fax
your order at  +49-221-31088-29, or call at  +49-221-31088-20. (Please note, however, that
this is a secure website which is encrypting all transmitted credit card data according to the
secure HTTP protocol.) 

US and Canadian customers:  You may also place your order by calling toll-free order
number 1-800-903-4152 (available on weekdays from 9am to 5pm). Orders may also be sent
by fax to (724) 850-8187. Please make sure to have your program ID 300015402 ready, and
follow the signposts, or telephone. 

BANK TRANSFER orders

Account holder: element 5 AG
Bank: Postbank Koeln, Germany
Bank #: 370 100 50
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Account #: 692-77-506

Your order will be processed when payment is received at account. 

CHECK and CASH orders

If you want to pay with cash or by check, please send it to:

element 5 AG
Vogelsanger Str. 78
D-50823 Koln/Cologne
Germany
Please make checks payable to element 5 AG. 

If you’re located in the US or Canada, you can also send your check or cash payment to
ShareIt! US office:

ShareIt! Inc.
P.O. Box 844
Greensburg PA 15601-0844, U.S.A.
Phone: (724) 850 – 8186
Fax: (724) 850 - 8187
Please make U.S. checks payable to ShareIt! Inc. 
When ordering please quote program/product ID 300015402 - Fast Link Checker

One license may be purchased if a single person uses the software personally on one or more
computers.  Having  paid  for  the  necessary  number  of  licenses  (discounts  for  multiple
licenses are available), you obtain your personal registration key.

Note, that we as developers DO NOT get access to your credit card number.

Contact
Thank you for trying Fast Link Checker. We hope you’ll enjoy using this software.

Please  feel  free  to  contact  us  with  any your  questions,  suggestions  and bug reports  by
following addresses:

support@webtweaktools.net

Please read the FAQ and write if you have additional questions or problems.

sales@webtweaktools.net

Currently  our  products  are  only  distributed  on  the  Internet.  If  you  are  interested  in
exchanging links with us, or would like to help us with physical distribution, promotion in
software compilations, or business cooperation, kindly let us know! We are open to various
levels of cooperation.

RegistrationProblems@webtweaktools.net

If you don’t receive your registration code in a timely manner, or if you’ve lost it, please let
us know. Please include your name, address, email address, and order confirmation number
(if you have it). We will be happy to help you.
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translation@webtweaktools.net

Email  your  translations  to  us!  If  we  choose  yours  for  the  next  version,  you’ll  get  our
products for free.

Homepage: http://www.webtweaktools.net

Hints and Tips
The “Tip of the Day” dialog box is normally displayed when you start Fast Link Checker.
You can turn “Tip of the Day” off by the check box bellow and later want see the tips, select
Tip of the Day from the Help pull-down menu. 

If  you are  behind  a  firewall,  Fast  Link  Checker  can support  HTTP and  SOCKS proxy
servers. Proxy servers may be customized on Connection tab of the Settings dialog. 

Learn to  use the Windows HtmlHelp system! Most  modern Windows programs use the
HtmlHelp system, so you will quickly make up for the time you spend learning it by being
more productive in most  your Windows applications.  To get started,  select  How to Use
Help from the Help menu. 

Fast Link Checker can perform some action upon link checking is finished. This action can
be a combination of the following options: Close Link Checker, Disconnect modem from
Internet and Shutdown Windows. You can set it in the Options tab of Settings dialog.

For answers to Frequently Asked Questions (FAQs), select  Frequently Asked Questions
from the Link Checker Help pull-down. 

Fast Link Checker can check links only in the one file. For perform this operation select
option Only check links in the first URL before click Start scanning command.

For a complete Tip of the Day list, select Hints and Tips from the Fast Link Checker Help
pull-down menu. 

Fast Link Checker can skip external links while link checking. For skip external links select
option Do not check external links before click Start scanning command.

Normally, Fast Link Checker does not check links on pages forbidden to be indexed by
robots in the robots.txt file. To let the program check links on pages forbidden to be indexed
by robots in the robots.txt file, select the  Ignore robots.txt file  option before clicking the
Start scanning command.

Normally, Fast Link Checker considered all links to be case-sensitive. But you can make
Fast Link Checker ignore the case of letters when it compares links by selecting the Ignore
case when comparing links option before clicking the Start scanning command.

You can restrict the level of subdirectories to be checked by selecting the Restrict checking
to directory level option. If you select this option, the program will ignore all files below
the specified level in the directory tree.
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Fast Link Checker allows you to create and save reports about the links checked on the site.
To generate a report, select the Export data… command in the Reports menu, specify the
parameters that should be present in the report and click the  Export data button to start
creating the report.

You can use the  User agent identification option on the  Connection tab in the  Settings
dialog box to specify the name of the user agent the program will use when requesting files
from a web server. This option can be useful if some web server gives different information
to different Internet browsers or if you want to configure Fast Link Checker to identify itself
as a certain user agent for you to be able to see its visits in your server log files.

Fast Link Checker implements a multithreaded algorithm allowing it to download and check
several pages at a time, which considerably increases the performance. You can use the
Number of network connections option on the Options tab in the Settings dialog box to
set the number of network connections.

Fast Link Checker can check links in files located in a certain directory only. To enable it,
specify the  URL of  this  directory in  the  URL field  before clicking the  Start  scanning
command. For example, if you specify http://www.mysite.com/mydata/ in the URL field, the
program will check all pages it will find in the mydata directory of the mysite.com site.

Frequently Asked Questions
1. What is Fast Link Checker?

Fast Link Checker is used for searching sites for broken links. It works like a robot of a
search engine (Googlebot, MSNBot, WISENutbot, Alexa, etc.). You specify the file to start
checking from and Fast Link Checker goes through all pages this file has links to until it
checks all links on the site. If Fast Link Checker finds a broken link, it shows its position in
the document, the cause why it does not work and a hint how it can be fixed.

2. Why is it important?

One of the most important indicators of a high-quality site is absence of broken links. There
is nothing worse for a user than coming across either a link that leads nowhere or an empty
square instead of an image. Broken links ruin your reputation and bring down your rating on
search engines.

3. Where can I get it?

You can download it from our web site:
http://www.webtweaktools.net/fastlinkchecker/download.html.

4. How do I register?

Fast Link Checker registration costs $49. You can register it by credit card, bank transfer,
check  or  cash.  Please  read  more  information  about  registering  Fast  Link  Checker  at
http://www.webtweaktools.net/fastlinkchecker/purchase.html.

5. The registration key you sent me doesn't work, why?

If most cases this happens simply because the name and number have not been typed into
the  registration  dialog  exactly  as  shown  in  the  registration  Email.  It  is  important  to
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remember that character case, punctuation, and spaces are significant. We suggest that you
cut and paste the name and number directly from your registration Email to the registration
dialog.

6. Why Fast Link Checker doesn't display help correctly?

If you do not have Internet Explorer 5 or higher, you may need hhupd.exe to use the Html
Help feature.

7. Why program does not start in Windows 95?

Windows Sockets 1.1 or later must be installed on your computer. You can download W95
Winsock Upgrade from Microsoft server:
http://www.microsoft.com/windows95/downloads/contents/WUAdminTools/S_WUNetwor
kingTools/W95Sockets2/Default.asp

Or from our server: http://www.webtweaktools.net/W95ws2setup.exe.

8. How  do  I  protect  Fast  Link  Checker  settings  from reinstalls,  upgrades  or
operating system crashes?

Fast Link Checker keeps all its settings in the "Fast Link Checker" folder located in your
"Application Data" directory. In order to save Fast Link Checker settings you can copy these
files somewhere else and when you'll need to restore Fast Link Checker settings you must
these files back to your "Application Data" directory. 

9. Can I set different location for Fast Link Checker settings?

Fast  Link Checker uses registry key to allow override its  settings files location.  Specify
directory  where  settings  files  are  located  in  the  string  value  "SettingsDir"  in  the  key
"HKEY_CURRENT_USER\Software\WebTweakTools\FastLinkChecker"  of  the  system
registry and restart  program. In the specified directory Fast  Link Checker will  keep file
settings.ini with its settings and folder AutoSave with auto-saved data.

10. Why Size/Last modified fields in the list are empty sometimes?

These fields are depending on the server. They are empty when the server did not return
their values.

11. Why HTTPS security links does not open on my system?

In order to  open pages with HTTP protocol you should have the High Encryption Pack
installed.  You  can  download  it  form  Microsoft's  website:
http://www.microsoft.com/windows/ie/downloads/recommended/128bit/default.asp.

12. Can I buy Fast Link Checker with PayPal?

Yes, now we accept PayPal. Please follow this link to Fast Link Checker registration form
with PayPal: http://www.webtweaktools.net/fastlinkchecker/paypal.html.
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Getting started

Checking links on a site
To start checking links, enter the address of the site into the URL field, set the necessary
values for other parameters and click the Start button. You can click the Pause button to
pause the process or the Stop button to stop it.

Fast Link Checker will download the page specified in the URL field, extract all links from
it  and try to  open each of them one by one to check their  availability. After  Fast  Link
Checker checks all links on the current page, it will move on to other pages in the order they
are detected in the first file.

The program puts all links it finds onto the Found Links list. Then it tries to open them and
puts  the  results  of  these  attempts  onto  the  Processing list  along  with  all  additional
information it receives from the server when opening the link. If the program finds a broken
link, it puts it onto the Broken Links list with the information about the page where it was
found, its position on the page and a possible cause why it does not work.

Checking links on a single page of a site
To check links on one page of a site, enter the address of this page into the URL field, select
the Only check links in the first URL option and click the Start button. You can click the
Pause button to pause the process or the Stop button to stop it.

Fast Link Checker will download the page specified in the URL field, extract all links from
it  and try to open them one by one to check their availability. After Fast  Link Checker
checks all links on the current page, it will finish its work.

Setting up a connection via a proxy server 
At present, Fast Link Checker supports the following types of proxy servers: HTTP, HTTPS
and SOCKS5. 

To change the settings of a proxy server, open the Connection tab in the Settings dialog and
check the Use a proxy server option, after that select the type of the proxy server, enter its
address  and  port  number.  If  your  proxy  server  requires  authentication,  check  the  Use
authentication  for  the  server option  and  enter  your  username  and  password  in  the
corresponding input fields.

Checking links on a site situated on the local computer
The best way to check links on a site situated on your local computer is to install a local web
server so that your local site becomes available at  http://localhost/. In this case you should
specify  http://localhost/ in  the  URL field  and  start  checking  links.  The  program  will
automatically check links on the site available on your local web server and all the options
will work as if the real address of a site on the Internet is specified in the URL field.

Note that if you access the Internet via a proxy server, you will probably have to disable it to
access the site on your local web server. To solve this problem, you can use the  Bypass
proxy for local  addresses option on the  Connection tab in the  Settings dialog box.  It
allows you to avoid using the proxy server for connecting to resources available at a local
URL.
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Fast Link Checker also supports the FILE protocol and can check links on pages located in
the file system of your computer. To use this protocol, you should specify the full path to the
file to start checking links from (for example, file://C:/myfolder/myfile.html). The program
will load the C:\myfolder\myfile.html page, extract all links from it and try to open each of
them to check its availability. After the program checks all links on the current page, it will
move on to other pages in order they are detected in the first file. The program will ignore
links to pages located below the current directory. All other options will work as if the real
address of a site on the Internet is specified in the URL field.

Configuring user agent identification
Fast  Link  Checker  allows  you  to  use  the  User  agent  identification option  on  the
Connection tab in  the  Settings dialog box to specify the user agent name. This  option
allows you to specify the name of the user agent the program will use when requesting files
from a web server. This option can be useful if some web server gives different information
to different Internet browsers, i.e. it shows the standard contents for Internet Explorer and
the content that is better displayed in Netscape for Netscape.

You can also configure Fast Link Checker to identify itself as a certain user agent for you to
be able to see its visits in your web server log files.

Creating and saving reports
Fast Link Checker allows you to generate reports about the links checked on the site. The
report  can  include  information  about  all  links  found  on  the  site,  about  links  either  to
hypertext documents only or to graphic objects only, as well as all broken links.

You can save such a report in the following formats: html, csv (Excel), text (tab delimited),
text  (comma delimited).  Each  found  link  is  accompanied  by the  following information
(customizable): URL, Title, Status, Protocol, Content-type, etc.

To generate a report about the work of the program, select Export data… from the Reports
menu, specify the parameters you need in the report and click the  Export data button to
start generating the report.

How to check links, which require user authorization
Since version 1.3 Fast Link Checker supports HTTP/HTTPS user authorization. Now you
can check links in pages which are protected with username and password. Simply specify
URL in the following format:  scheme://username:password@domain.zone/resources/files,
for  example:  http://johns:n135hbh35@yoursite.com or
http://stan:xn381bb3b@yoursite.com/dirfiles/.

Reference

Main window
You can open a worksheet by selecting the New command from the File menu. It is divided
into two parts. In the left part you can see the individual settings of the current check. The
right part shows the process of checking links.
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To start checking links, enter the address of the site into the  URL field, set the necessary
values for other parameters and click the Start button. You can click the Pause button to
pause the process or the Stop button to stop it.

The  Reports menu contains commands for creating and saving reports about the work of
Fast Link Checker.

You  can  save  the  worksheet  of  the  current  window  by selecting  the  Save  worksheet
command from the  File menu.  The program saves the current  state  of the check in the
current  window at  the  current  moment.  You  can  restore  the  worksheet  with  the  Load
worksheet command from the File menu.

Each worksheet is also saved automatically when you close the program, so you can pause
the current check and close the program. When you open it next time, the worksheet will be
restored and you can continue checking links by clicking the Start button.

URL

The address of the site to check links on. It can consist of a protocol name, a domain name
and a link to the resource. For example, http://www.mysite.com/index.html. In this example,
the program will check all pages on mysite.com starting from index.html. Another example
is  http://www.mysite.com/subdir/. In this example, the program will check all pages in the
subdir directory of mysite.com.

Display site name as

This name is to substitute instead of the actual site name. So the report will contain this site
name.  For  example,  when  checking  http://www.mysite.com/index.html you  can  specify
"myanothersite" in "Diaplay site name as" and all the links to mysite will be displayed as the
links to myanothersite. 

Recheck bad links

This option allows you to automatically re-check links which are failed due to a system
errors such as timeout, error reading file, socket errors, etc., which appeared on your local
system, not on web-server.

Check hyperlinks

Select this option to check links to hypertext pages.

Check images

Select this option to check links to graphic objects.

Check other links (script, css…)

Select this option to check links to scripts, style sheets and other objects.

Ignore robots.txt file

Normally, Fast Link Checker does not check links on pages forbidden to be indexed by
robots in  the  robots.txt  file.  Select  this  option  to let  the program check links  on pages
forbidden to be indexed by robots in the robots.txt file.
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Check links only in the first URL

This option allows you to check links only on the page specified in the URL field. The
program will not follow links it will find on this page, but will only check their availability.

Do not check external links

Normally, Fast Link Checker checks all links that lead from the current site to other external
sites. You can change this behavior by selecting this option. The program will ignore links
to other sites and check only links within the current site.

Ignore case when comparing links

Normally, Fast Link Checker considers all links to be case-sensitive. Select this option to
make Fast Link Checker ignore the case of letters when comparing links.

Restrict checking to directory level

If you check links on large sites, you can restrict the level of subdirectories to be checked.
For example,  if you specify "3" in this field,  the program will  not check links on pages
below the third level from the checking folder. When checking links on www.mysite.com
pages  located  in  the  directory  www.mysite.com/level_1/level_2/level_3/ will  not  be
checked.

This  option  allows  you  to  check  links  on  large  sites  in  parts,  restricting  the  level  of
subfolders.

Check files in parent directory

Normally, if you specify start URL like "http://www.mysite.com/subdir/", the links in the
directory "subdir" will only be checked. With this option entire site will  be checked not
depending on the start directory.

Check only files below/above size

Skip all files which size is greather or less than specified number of kilobytes.

Do not check slow links

Skip checking all links marked as slow. Normally slow links are checked like all other links
but when this option is set all slow links will be skipped. See also Slow link time options on
the Options tab of Settings dialog.

Check only the following files

Skip  all  files  which do not  meet  the  wildcards  specified.  Use semicolon (;)  to  separate
entries. For example, if you specify "/files/*.html;/dir/*" then will be checked only: (a) all
html files in the "files" directory and (b) all files in the "dir" directory and its subdirectories.

Skip the following files

Skip  all  files  which do not  meet  the  wildcards  specified.  Use semicolon (;)  to  separate
entries. For example, if you specify "/files/*.html;/dir/*" then will be checked only: (a) all
html files in the "files" directory and (b) all files in the "dir" directory and its subdirectories.
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Processing

This list contains links either already checked or being checked at the moment and the state
of checking (whether the resource the link refers to is found and the description of the error
if the resource is not found).

Site layout

Site  layout  represents  the  structure  of  the  site  being checked with  its  folders  and  files.
Broken links are marked by the error sign in the icon. Hold mouse cursor over an item to
view extended information for it.

Broken links

This list contains all broken links found on the site, the page where they are located, their
position there and a possible cause why they do not work.

Settings (Options/Connection/File Extensions)
Options

URL Timeout

Timeout value, through which time server request will be canceled if there is no answer
from the server.

Slow link time

Time value, through which time a checking link will be marked as a slow link.

Number of network connections

Number  of  network  connections,  which  may be  opened  at  a  time.  This  allows  loading
several files simultaneously and considerably increases the performance.

Number of connections to the same server

Number of network connections to the same server, which may be opened at a time. This
allows reducing server load and avoiding some server errors such as too many connections
opened.

User agent identification

The name of the user agent the program will use when requesting files from a web server. 

Upon finishing

When the program has finished checking all links the following actions may be performed:

• Close Link Checker

• Disconnect modem from Internet

• Shutdown Windows
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Connection

If you are using a proxy server for connecting to the Internet, it can be still available to
check your site for broken links with Fast Link Checker. You just need to know what type of
proxy you use, its address and port number. Currently Fast Link Checker supports HTTP
and SOCKS proxy servers.

If your proxy server requires authentification, you must check Use authentification for the
server check box and specify your user name and password in the corresponding boxes. 

Note that if you access the Internet via a proxy server, you will probably have to disable it to
access the site on your local web server. To solve this problem, you can use the  Bypass
proxy for local  addresses option on the  Connection tab in the  Settings dialog box.  It
allows you to avoid using the proxy server for connecting to resources available at a local
URL.

File extensions.

When the program checks links on the site, it uses information from the  File extensions
dialog box to determine the type of files links refer to. For example, if Link Checker finds a
link referring to a file that has an extension specified in the HTML list, it will follow this
link and load the file to check links in it. But if the program finds a link referring to a file
that has an extension specified in the Image list, Link Checker will just check its availability
without loading its contents.

The following file types can be specified:  Application,  Audio, HTML, Image, Text  and
Video. Each file type must have a list of file extensions belonging to it. A list can have any
number of extensions separated by blank spaces.

Reports
Fast Link Checker allows you to generate reports about the links checked on the site. The
report  can  include  information  about  all  links  found  on  the  site,  about  links  either  to
hypertext documents only or to graphic objects only, as well as all broken links.

You can save such a report in the following formats: html, csv (Excel), text (tab delimited),
text  (comma delimited).  Each  found  link  is  accompanied  by the  following information
(customizable): URL, Title, Status, etc.

To generate a report about the work of the program, select Export data… from the Reports
menu, specify the parameters you need in the report and click the  Export data button to
start generating the report.

Common user-agent types
Every time you go to a website, you send what is called a User Agent string. Every browser
has one. Most of them start with the word "Mozilla". Mozilla has always been the nickname
for the browser made by Netscape. (And now, we have a browser called Netscape and a
different browser called Mozilla, both of which identify themselves as Mozilla).

Let’s take a look at a few examples:

Internet Explorer sends this:
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"Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1)"

Opera (by default) sends this: 

"Mozilla/4.0 (compatible; MSIE 5.0; Windows XP) Opera 6.05 [en]"

Mozilla sends this: 

"Mozilla/5.0 (Windows; U; Windows NT 5.1; en-US; rv:1.1)"

They  all  start  with  the  word  "Mozilla"  because  an  early  version  of  Netscape  (which
identified itself as "Mozilla") could handle more complex HTML than early versions of
Internet Explorer. Web designers were swept up into a practice that would haunt them yea
unto the gates of hell: they started Sniffing Browsers. Basically, they looked at the User
Agent  string  and  started  to  give  different  content  to  different  browsers.  Then  Internet
Explorer added functionality to  handle more complex HTML, but  since some folks  had
already started looking for the word "Mozilla" in the User Agent string, Microsoft decided
that they would adopt it too.

HTTP Error Codes and their descriptions
100-199 Informational

100 Continue - The client can continue its request.

101  Switching  Protocols  -  The  server  has  complied  with  the  client's  request  to  switch
protocols.

200-299 Success: indicates that a client's request arrived and was accepted.

200 OK - The request was successful.

201 Created - The request was successful and a new resource was created as a result.

202 Accepted - The request was accepted for processing.

203 Non-Authoritative Information - The meta-information in the entity-header is from a
local or third-party copy.

204 No Content - The server serviced the request but there is no information to return.

205 Reset Content - The request was successful and the user agent should clear the input
form for further input.

206 Partial Content - The server serviced a (byte) range request for the resource.

300-399 Client request redirection, further action required.

300 Multiple Choices - The requested resource could be one of multiple resources.

301 Moved Permanently - The requested resource has permanently moved to a new location.

302 Moved Temporarily - The requested resource has temporarily moved to a new location.
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303 See Other - The response to the request is under a different URI and can be retrieved
with a GET request.

304  Not  Modified  -  The  requested  resource  has  not  been  modified  since  it  was  last
requested.

305 Use Proxy - The requested resource must be accessed through a proxy server.

400-499 Client error

400 Bad Request - The server cannot read the request because its syntax is incorrect.

401 Unauthorized - The server must authenticate the user before servicing the request.

402 Payment Required

403 Forbidden - The server refused to service the request.

404 Not Found - The server cannot find the requested resource.

405 Method Not Allowed - The method specified in the Request-Line is not permitted for
the requested resource.

406 Not Acceptable - The requested resource can only generate response entities that have
unacceptable content characteristics according to the accept headers sent in the request.

407 Proxy Authentication Required - The proxy server must authenticate the user before
servicing the request.

408 Request Timeout - The client did not make its request within the amount of time the
server will wait for requests.

409 Conflict - The server could not service the request due to a current conflict with the
requested resource.

410 Gone - The requested resource is no longer available on the server.

411 Length Required - The server will not service the request without a Content-Length
specified in the request.

412 Precondition Failed - A precondition specified in one or more of the request-header
fields failed.

413 Request Entity Too Large - The server will not service the request because the requested
resource is too large.

414 Request-URI Too Long - The server will not service the request because the requested
URL is too long.

415 Unsupported Media Type - The server will not service the request because the format of
the request is not supported by the requested resource for the requested method.

500-599 Server error
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500  Internal  Server  Error  -  The  server  could  not  service  the  request  because  of  an
unexpected internal error.

501 Not Implemented - The sever cannot service the request because it does not support the
request method.

502 Bad Gateway - The proxy server received an invalid response from the content server or
another proxy server in a proxy chain.

503  Service  Unavailable  -  The  server  could  not  service  the  request  because  it  was
temporarily overloaded or undergoing maintenance.

504 Gateway Timeout - The proxy server did not receive a response from a chained proxy
server or the origin content server within an acceptable amount of time.

505 HTTP Version Not Supported - The server does not support the HTTP version specified
in the request.

Settings.ini file
Please note: most settings in Settings.ini can also be changed from dialog boxes. Very few
settings can only be changed directly, either because they are not meant for the end user, or
they are only a workaround to a specific problem. 

Note: By default Fast Link Checker keeps all its settings in the "Fast Link Checker" folder
located  in  your  "Application  Data"  directory.  But  this  location  may  be  overridden  by
specifying another directory where settings files are located in the string value "SettingsDir"
in the key "HKEY_CURRENT_USER\Software\WebTweakTools\FastLinkChecker" of the
system registry. In the specified directory Fast Link Checker will keep file settings.ini with
its settings and folder AutoSave with auto-saved data.

[Options] General settings
CurrLang= Current interface language
MainWndX=

MainWndY=

MainWndCX=

MainWndCY=

Main window location

MainWndMaximized=0 1: Main window is maximized
ShowStartTips=1 1: Show startup tips
CurrentTip= Number of the current tip
URLTimeout=60 URL timoout
SlowTimeout=5 Slow link time
NumThreads=10 Number of the network connections
CharSet=<Auto-Detect> Charset to decode HTML files 
DefCharSet=US-Ascii Default  charset  (when  unable  to  auto-

detect)
ThreadsPerServer=2 Maximal number of connections to the same

server
AgentType= User-agent type
AgentOS= User-agent OS
HTTPVer=1 0: HTTP 1.0

1: HTTP 1.1
CloseWhenDone=0 Close Fast Link Checker when done
DisconnWhenDone=0 Disconnect modem from Internet  when done
ShutdownWhenDone=0 Shutdown Windows when done
UseProxy=0 1: Use proxy server
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ProxyBypassLocal=0 1: Bypass proxy for local addresses
ProxyUseAuth=0 1: Proxy server uses authentification
ProxyUserName= User name for proxy server authentification
ProxyPassword= Password for proxy server authentification
HTTPProxyType=1 1: HTTP

2: SOCKS5
HTTPProxyAddress= Proxy server address for HTTP connection
HTTPProxyPort= Proxy server port for HTTP connection
HTTPSProxyType=1 1: HTTP

2: SOCKS5
HTTPSProxyAddress= Proxy server address for HTTPS connection
HTTPSProxyPort= Proxy server port for HTTPS connection
FTPProxyType=1 1: HTTP
FTPProxyAddress= Proxy server address for FTP connection
FTPProxyPort= Proxy server port for FTP connection
ExtApp= File extensions for Application files
ExtAudio= File extensions for Audio files
ExtHTML= File extensions for HTML files
ExtImage= File extensions for Image files
ExtText= File extensions for Text files
ExtVideo= File extensions for Video files

[SiteDefault] Most recently used strings for URL combo

Command line tool
Command Line:
conlinkchecker --Site URL [-CheckHyperlinks] [-CheckImages]
  [-CheckOthers] [-RecheckBad RecheckTimes]
  [-IgnoreRobotsTxt] [-CheckFirstOnly]
  [-CheckNoExtern] [-CheckIgnoreCase] 
  [-CheckRestrict CheckLevel] [-CheckParent]
  [-SizeLimitAbove | -SizeLimitBelow] [-SkipSlowLinks]
  [-CheckOnly wildcards] [-Skip wildcards]
[--SiteFile file[.flc]]
[--Disp servername]
[--Cache]
[--Ini inifile.ini]
[--Verbosely]
[--PrintBroken]
[--UserAgent AgentName]
[--Report] [ html | text | htmlfull | textfull | htmlstat |
   textstat | csvstat] [-Attach] [filename/email 
   [smtpserver:port [username [password]]]]

--Site
  URL - The address of the site to check links on.
  [-CheckHyperlinks] - Specify this option to check links to
hypertext pages.
  [-CheckImages] - Specify this option to check links to
graphic objects.
  [-CheckOthers] - Specify this option to check links to
scripts, style sheets and other objects.
  [-RecheckBad RecheckTimes] - Re-check links which are
failed due to a system errors such as timeout, error reading
file, socket errors, etc., which appeared on your local
system, not on web-server.
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  [-IgnoreRobotsTxt] - Specify this option to let the program
check links on pages forbidden to be indexed by robots in the
robots.txt file.
  [-CheckFirstOnly] - Specify this option to check links only
on the page specified in the URL field.
  [-CheckNoExtern] - Specify this option to ignore links to
other sites and check only links within the current site.
  [-CheckIgnoreCase] - Specify this option to make Fast Link
Checker ignore the case of letters when comparing links.
  [-CheckRestrict CheckLevel] - Specify this option to
restrict the level of subfolders.
  [-CheckParent] - Check entire site not depending on the
start directory.
  [-SizeLimitAbove | -SizeLimitBelow] Skip all files which
size is greather or less than specified number of kilobytes.
  [-SkipSlowLinks] - Skip checking all links marked as slow.
Normally slow links are checked like all other links but when
this option is set all slow links will be skipped.
  [-CheckOnly wildcards] - Skip all files which do not meet
the wildcards specified.
  [-SkipFiles wildcards] - Skip all files which do not meet
the wildcards specified.

[--SiteFile file[.flc]] - When link checking will be done
Fast Link Checker will save results to the specified file.

[--Disp ServerName] - This name is to substitute instead of
the actual site name.

[--Cache] - save cache of all downloaded files to the folder
"\Documents and settings\[User name]\Application Data\Fast
Link Checker\Cache", where [User name] is the user name you
have logged into the system.

[--Ini inifile.ini] – You can specify the file with Fast Link
Checker settings. If this option is not specified, the
standard Fast Link Checker settings file will be used.

[--Verbosely] – Specify this option to view link checking
progress verbosely.

[--PrintBroken] – Specify this option to view all found
broken links verbosely.

[--UserAgent AgentName] – The name of the user agent the
program will use when requesting files from a web server.
Default value - "Mozilla/4.0 (compatible; MSIE 6.0; Windows
NT 5.1".

[--Report] - Fast Link Checker can save report to a file or
send it to email address. Multiple "--Report" statements may
be specified.
[ html | text | csv | htmlfull | textfull | csvfull |
htmlstat | textstat ] - Type of report
html - broken links in HTML format,
text - broken links in text format,
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csv - broken links in csv format,
htmlfull - all links in HTML format,
textfull - all links in text format,
csvfull - all links in csv format,
htmlstat - statistics only in HTML format,
textstat - statistics only in text format,
csvstat - statistics only in csv format.
[-attach] - Send report as attachment (if [email] specified).
[filename/email] – Name of a file to save report in or email
address to send report to.
[smtpserver:port] – Name and port of SMTP server for the
specified email address.
[username] – User name for SMTP server, if it requires
authentification.
[password] – Password for SMTP server, if it requires
authentification.

Troubleshooting
Program skips some files while checking links

Fast Link Checked checks the links in the files, whose type is defined in the HTML field of
the File Extensions dialog box. For make Fast Link Checked to check links in the files which it
skips, just add their extensions to the HTML field of the File Extensions dialog box and then
program will not skip these files.

Program does not check external links

Please make sure  that  option  Do not check external  links is  not  checked. This  option
prohibits checking the external links.

Program does not checks Gopher, News and mailto: links

Fast Link Checker supports only the following protocols for accessing files: HTTP, HTTPS,
FTP and FILE. Links to resources, available by other protocols are ignored.

Program does not check links on a page, which is not linked to from other pages

Fast  Link Checker  works  like  a  robot  of  a  search engine.  You specify the  file  to  start
checking from and Fast Link Checker goes through all pages this file has links to until it checks
all links on the site. Thus, if it  does not find a link to some page, it will not know about its
existence and will not check links in it.

So, to check links on this page you should specify its address directly in the URL field and
start link checking.
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